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II
Web Page Authoring
Fundamentals

How to create a Web site is one of the most empowering skills

you will ever learn. Because the Internet is ubiquitous, Web page cre-

ation gives you a worldwide reach that enables you to communicate

your message virtually everywhere. This part of the book teaches you

how to put any form of media, including text, pictures, audio, and

video, onto your Web pages. After studying Web page creation strate-

gies, you learn how to create a résumé you can use to apply for a job.

Creating a résumé on the Web provides you with the strategic advan-

tage of being able to give prospective employers the World Wide Web



address of your résumé. This shows you have network savvy that can

benefit an employer in an information society.

You also learn how to create your home page—the Web page

that establishes your identity on the Web. By linking things to your

home page, you can create a hierarchy that makes it easy for people to

access resources you put on the Web. For example, you will link your

Web page résumé to your home page.

Next, you learn how to interact with users by creating Web forms

that enable your visitors to make choices as you keep track of each

user’s preferences. You will be pleasantly surprised by how easy it is to

create a Buy Now button you can use to sell things at your Web site.

Then you learn how to write little computer programs called scripts,

which you can use to create more highly customized interactions.

Studying cascading style sheets (CSS) and the document object

model (DOM) will reveal all of the dynamic objects and methods that

are at your command. These are the raw materials of the digital age

that companies such as Amazon, eBay, Google, and Yahoo! have used

to build their empires. Learning these technologies will place the same

potential for invention into your hands. Whether you end up creating

something new or just studying to pass the CIW Foundations exam,

Web creation is an exciting journey you are sure to enjoy.
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“If you can dream it, you can do it.”

—Adobe slogan
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In this chapter, you will
learn how to:

■ Identify the Web page creation
strategies and adopt a strategy
that is appropriate for your
workplace.

■ Define the HTML Web page
elements and explain what they
do on a Web page.

■ Describe the principles of good
screen design and give examples
of each principle in action on a
Web page.

■ Analyze the layout of a Web
page résumé by diagramming
the HTML elements the page
comprises.

AC C O R D I N G to the Adobe slogan quoted at the beginning
of this chapter, “If you can dream it, you can do it.” This adage implies that
you have the proper tools for doing what you dream. Enabling you to ac-
quire these tools is what this chapter is about. First, this chapter takes you
on a guided tour of the approaches various authors use when creating Web
pages. Some of these approaches are surprisingly simple and cost-effective.
Others are more expensive but may save you time or money in the long
run. By reflecting on these choices, you can get a sense of what the proper
tool is for different situations.

No matter what tool you adopt, every Web author needs to understand
the HTML elements a Web page comprises. The second part of this chap-
ter defines and illustrates those elements at work on actual Web pages.
Then the third part helps you understand the screen design principles you
should follow to make appropriate use of HTML elements onscreen.

Finally, this chapter concludes by analyzing the layout of a Web page
that uses these elements to create a résumé, an important document that
potential employers expect you to show them when you are looking for a
job. This chapter enables you to dream up the content and visualize the ap-
pearance on the screen of your Web page résumé. In the next chapter, you
will actually create such a résumé, which will come in handy whenever you
are looking for a job.

Adopting a Web Page Creation Strategy

There are four ways to create Web pages. First, you can use a plaintext editor
to type the HTML code of your Web page by hand. Doing this requires that
you know the HTML tags, because a plain text editor does not have any built-
in help for HTML coding. Second, you can use an HTML editor that contains
toolbars and menus that help you insert the codes. This built-in help makes it
easier to create a Web page, but still it is technical and requires that you have a
good understanding of how HTML works. Third, you can use the Save As
Web Page option to convert word-processed documents into Web pages. This
is the most productive way to create Web pages from term papers and other
forms of scholarly writing. Fourth, you can use a what-you-see-is-what-you-
get (WYSIWYG) editor to create Web pages through a graphical user inter-
face that lets you enter text and graphics directly onto the screen exactly as
you want them to appear. As you create the screen, the WYSIWYG editor au-
tomatically generates the HTML codes that make the Web page.



Text Editors

You may be surprised to hear that some of the Web’s most successful au-
thors create their pages with a text editor. Because HTML is a textual en-
coding language, you can use a plaintext editor to create HTML Web
pages. This book saves you some money by taking advantage of this fact.
Instead of requiring you to buy a fancy tool, this book is written so you can
complete all the HTML exercises with a simple text editor that you al-
ready own. If you have one of the fancier tools, on the other hand, you
can also work through this book’s tutorials with your more high-end
tool. Before discussing more high-end tools, however, let us review the
text editors you can use to create Web pages without needing to purchase
any other software.

Notepad All Windows computers have a built-in text editor called Note-
pad. To get the Notepad running, you double-click its icon, which looks
like the notepad after which it is named.

If the Notepad’s icon is not visible, use the Windows Start | Programs |
Accessories menu. If you have a Macintosh, use the Finder to locate the
Notepad’s launch icon. If you have OS X, the Macintosh text editor is
called TextEdit.

WordPad In addition to the Notepad, the Windows operating system
has a more powerful text editor called the WordPad.

The choice of which text editor to use is totally yours. Beginners
might find the Notepad less confusing because there are some rich text
format (RTF) tools in the WordPad that are not applicable to HTML
Web page creation. You cannot, for example, create HTML italics or
bolding by clicking the italics or bold options on the WordPad’s toolbar.
Instead, you must type the HTML codes, which you will learn later in
the next chapter.

HTML Editors

As you learned in the first part of this book, Web pages are encoded in the
hypertext markup language (HTML). This language consists of the text of
the Web page plus special codes called tags that mark up the text. The tags
determine how the text will flow onto the screen, whether it will contain
pictures and where they will appear, and what will happen when the user
triggers items linked to the document. An editor that lets you create
Web pages by working directly with the HTML tags is known as an HTML
editor. The advantage of creating Web pages with an HTML editor is that
it gives you more control over the Web page than WYSIWYG editors and
HTML translators, which create the HTML for you. The disadvantage is
that for less technically inclined authors, editing HTML tags can seem te-
dious and time-consuming. The latest versions of the HTML editors, how-
ever, contain helpful dropdown menus so you can choose tags from a list as
you type your code.
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HomeSite

HomeSite is a popular HTML editor for creating Web pages under the
Windows operating system. As shown in Figure 5-1, HomeSite lets you
edit the HTML in one window and view how it will appear on the Web in
another. HomeSite is a product of Macromedia, which sells it as a
standalone package or in bundles with Macromedia’s Dreamweaver soft-
ware. For more information, go to www.macromedia.com/homesite,
where you can get a 30-day free trial version.
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note HomeSite was used to
create the color-coded examples of
HTML code that appear in the rest of
this book’s tutorials. This coloration is
especially helpful for beginners who are
learning HTML syntax.

FIGURE 5-1 HomeSite lets you edit the HTML source code in the Edit window. To see the
resulting Web page, you click the Browse tab. �

The Edit tab shows
the HTML editor.

The Browse tab shows
the resulting Web page.



BBEdit

On the Macintosh, the most popular HTML editor is Bare Bones Edit
(BBEdit). As illustrated in Figure 5-2, BBEdit uses menus and buttons to
make it easy to input HTML tags, choose colors, and enter special sym-
bols. For more information, go to www.barebones.com/products/bbedit,
where you can get a free demo version.

Other HTML Editors

There are dozens of other HTML editors that help you create Web pages
by working directly with HTML tags. For information about the others,
follow this book’s Web site links to the Google and Yahoo! directories of
HTML editors.

HTML Translators

An HTML translator is a tool that can convert an existing document into
the HTML format. Microsoft Word, Excel, Access, and PowerPoint have
HTML translators built in. If you have an existing document that you
want to turn into a Web page, the most efficient way to create the page is to
pull down the File menu and choose the Save As Web Page option.
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FIGURE 5-2 BBEdit uses menus and buttons to make it easy to input HTML tags, choose colors, and
enter special symbols. �



Word

Microsoft Word is a word processor that has an HTML translator built in.
After you create a document with MS Word, you can easily translate it into
a Web page. Simply pull down the File menu and choose Save As Web
Page. This creates an HTML version of your document with the .htm file-
name extension. To see what the translated document will look like on the
Web, you can use the browser’s File menu to open the file you just saved.

Excel

Imagine being able to publish your spreadsheets to the Web. You can do
this with Microsoft Excel. Simply pull down the File menu and choose
Save As Web Page. This creates an HTML version of the spreadsheet with
the .htm filename extension. To preview what the spreadsheet will look
like on the Web, you can use your Web browser’s File menu to open the
HTML version you just saved. The information in your spreadsheet lines
up neatly formatted in rows and columns on the Web page. HTML table
tags are used to create the rows and columns. You will learn how to create
tables with HTML in Chapter 6.

Access

Access is the name of the database program in Microsoft Office. To create
a Web page version of a data table, you first select the table to view it. Then
pull down the File menu and choose Export. When the Export dialog ap-
pears, set the Save As Type field to HTML Documents. Then click the Save
button. This creates an HTML version of the data table that has the .htm
filename extension. To preview how the data will appear on the Web, you
can use your Web browser’s File menu to open the HTML version you just
saved. In Chapter 7, you learn how to publish the file to the Web.

PowerPoint

Microsoft’s presentation software is called PowerPoint. It has a very pow-
erful Web page creation capability. When you choose the option to save a
presentation as a Web page, PowerPoint goes through your presentation
and creates a separate HTML file for each one of your slides. The filename
of your first slide is the name of your presentation followed by the .htm file
extension. The HTML files for the rest of your slides get placed into a sup-
porting folder that also includes any sounds and graphics used in your pre-
sentation. When you view the presentation with a Web browser, a menu of
your slides appears alongside the startup screen, as shown in Figure 5-3.
To navigate the Web site, the user can either click items on your presenta-
tion screen or use the menu to go to any slide at any time.

One of my other books, titled Multimedia Literacy, has a complete tu-
torial on creating multimedia applications and publishing them to the
Web with PowerPoint. For more information, go to www.mhhe.com/cit/
hofstetter.
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FIGURE 5-3 When you save a PowerPoint application as a Web page, PowerPoint creates
a menu that lets the user jump to any slide at any time. You learn how to

create this kind of menu in the frameset section of Chapter 7. PowerPoint does all this work for you,
saving you the time you would otherwise need to spend creating such a menu. �

Users can click items in this menu
to jump to any slide at any time.

The browser displays your PowerPoint
application in the large frame on the right.

Using a Word Processor to Make a Web Page
Both Microsoft Word and WordPerfect have HTML translators built in. Whenever you need to create an
HTML version of a word-processed document, using this built-in translator will come in handy. To experience
the power of an HTML translator, follow these steps:

1. Use Microsoft Word or WordPerfect to open a document you have written recently, such as a term
paper or an essay.

2. Pull down the File menu and choose the option to Save As Web Page or Save As HTML. When the
Save dialog appears, name the file whatever you want, but make careful note of what you name it.
The filename extension will be either .htm or .html.

3. Get your Web browser running. Pull down the File menu, choose Open, click the Browse button,
and use the controls to open the Web page you saved in the preceding step.

4. Compare how the document appears in your browser to how it looks in your word processor. Can
you see any differences? If so, what are they? Did anything happen in the translation process that
you would like to change in the Web page version of your document? You will be able to make these
kinds of changes in your HTML documents after you complete this book’s Web page creation tutorial.

Try This!
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WYSIWYG Editors

WYSIWYG is an acronym that stands for what you see is what you get. In
a WYSIWYG editor, you create Web pages by typing your text directly
onscreen, where it appears exactly as it will look on the Web. To change a
font, size, color, or other text attribute, you select the text you want to
change and then click a button or icon that makes the change. You do not
need to know the HTML tags, because the WYSIWYG editor inserts them
into the document automatically, depending on what you do with the
WYSIWYG controls.

Dreamweaver

This chapter began by quoting the Adobe slogan, “If you can dream it, you
can do it.” The title of Macromedia’s Dreamweaver software plays on this
theme by implying that you can weave your Web via graphical tools that
can do a lot of the work for you. Figure 5-4 shows how Dreamweaver ap-
pears onscreen. For authors who are less technically inclined, using a
WYSIWYG tool such as Dreamweaver is easier than using a tag-oriented
HTML editor. When you work with WYSIWYG tools, however, you do
not have as much control over the appearance of the Web page as when
you work directly with the HTML tags. To overcome this limitation,
Dreamweaver provides a Code window where you can edit the tags di-
rectly. Figure 5-4 shows a Split view in which Dreamweaver simulta-
neously displays both the Code window and the WYSIWYG window. Any
change you make in the Code window takes effect immediately in the
WYSIWYG window, and vice versa. Thus, Dreamweaver provides you
with the best of both worlds. A free-trial version of Dreamweaver is avail-
able at www.macromedia.com/dreamweaver.

FrontPage

Designed for use with Microsoft Office, the FrontPage Web page editor
combines a WYSIWYG tool with an HTML editor. You can use the WYSI-
WYG tool to create a Web page in one window, and, at any time, you can
switch to an HTML window where you can view and edit the HTML tags.
Changes you make in the HTML window take effect instantly in the
WYSIWYG window, and vice versa. FrontPage also includes support for
creating advanced Web pages that use databases and scripts. Figure 5-5
shows a Web page being edited by Microsoft FrontPage. A free-trial ver-
sion is available at www.microsoft.com/frontpage.
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FIGURE 5-4 Dreamweaver lets you view the WYSIWYG Design view, the Code view, or both views
simultaneously. Illustrated here is the Split view, which displays both views onscreen. �

This is the
Code window.

Split the screen
to display both
the code and
the design.

Display the
WYSIWYG
Design view.

Display the
code view.

This is the
Design window.

You can edit
aspects of the
selected element
in the property
manager.

The Reference
tab puts at your
fingertips all the
documentation
you need.

The Files tab
makes it easy to
find resources
that you can
drag and drop
onto your page.

FIGURE 5-5 Microsoft FrontPage is editing my home page. At any time, I can click
the HTML button to view the code, or I can click the Preview button

to see how the page will appear on the Web. �



Netscape Composer

Netscape Composer is the name of the WYSIWYG Web page editor that
comes as part of the suite of tools in Netscape Navigator. Figure 5-6 shows
what Composer looks like onscreen. An HTML Source button lets you edit
the code, and a Preview button shows you how the page will appear in the
Netscape Web browser. Netscape Navigator is freely downloadable from
www.netscape.com. To launch the Composer, you pull down the Netscape
browser’s Tasks menu and choose Composer.

Defining the Elements of Web Page Design

World Wide Web pages consist of elements defined in the HTML language
that is used to create Web pages. As illustrated in Figures 5-7 to 5-15, these
elements include:

Internet Technologies at Work

FIGURE 5-6 Netscape Composer is editing my home page. At any time, I can click the
HTML Source button to view the code, or I can click the Preview button to

see how the page will appear in the Netscape Web browser. �

� Backgrounds

� Bookmarks

� Frames

� Headings

� Horizontal rules

� Images

� Links

� Lists

� Paragraphs

� Special characters

� Tables
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Headings

As illustrated in Figure 5-8, there are six HTML heading styles, numbered
from H1 to H6. The smaller the number, the bigger the heading. H1 is the
biggest or most important heading, and H6 is the smallest. Headings can
be left justified, centered, or right justified. Although it is possible to create
the same visual effect by simply enlarging and bolding the text, you can use
heading styles to create a structure within a document that programs such
as Microsoft Office can use to generate an outline or a table of contents.
Therefore, it is a good idea to form the habit of using heading styles for the
headings of sections and subsections within a Web page.

Paragraphs

Paragraphs consist of plaintext that flows onto the screen in a continuous
stream of characters. Paragraph text automatically wraps at the right mar-
gin and adapts to changes in window size.

Horizontal Rules

A horizontal rule is a design element used to create a divider between sec-
tions of a Web page. As illustrated in Figure 5-9, horizontal rules appear with
a neat three-dimensional effect. It is possible to vary the length, thickness,
and shading of a horizontal rule, but the default settings look pretty good.

FIGURE 5-7 Web page elements in action on my Web page résumé. The user can click any item in
the bulleted list to jump to that section of the résumé. The next chapter shows you how

to create your own Web page résumé, which will come in handy any time you are looking for a job. �

Heading

Image

Table

List

Paragraph

Links

Horizontal
rule



Lists

Lists can be ordered or unordered. In an ordered list, the items are num-
bered automatically; in an unordered list, the items are bulleted. Figure 5-9
shows examples of both types of lists.
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FIGURE 5-8 There are six HTML heading styles that you can put onto a Web page.
Onscreen, the headings appear larger or smaller, depending on their level of

importance. Behind the scenes, the headings create a document structure that programs such as
Microsoft Office can use to generate an outline or a table of contents. �

FIGURE 5-9 Horizontal rules and lists help organize and delimit information on a
Web page. �



Images

Images enhance the visual appeal of Web pages. Images
can be left justified, right justified, or centered on the
screen. Text can be made to flow around the left or the
right side of an image, as illustrated in Figure 5-10.

Backgrounds

Backgrounds can be filled with a solid color, or you can
tile a bitmap into the background to create a textured
appearance. It is important to choose a background that
does not detract from the readability of the text. For this
reason, black text on a white background is the most fre-
quent color choice on the Web.

When the Web started, the default background color
was defined as gray. When the default black text color
displays on a gray background, the screen is not as
readable as black text on a white background, which
provides better contrast. Figure 5-11 compares the
black-on-gray color combination to the more readable
black-on-white color scheme.

Bookmarks

A bookmark is a named anchor to which you can link a hot word or menu
item so users can jump around to different places within a Web page. For
example, you might create a bookmark anchor named “education” at the
start of the education section of your résumé. In your résumé’s bulleted
table of contents, you would link the education bullet to the bookmark
anchor named “education” to provide a quick way of jumping to your
educational qualifications.
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FIGURE 5-10 Text can flow around the left or the right side of
an image. �

FIGURE 5-11 When the Web started, the default background color was defined as gray, as illustrated on the left.Notice how much harder it is
to read the text when it appears on the gray background as compared to the white background illustrated on the right. �
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Links

Links are the most essential element in Web design, because links create
webs. Without links, there would be no webs! On World Wide Web pages,

links can be textual or pictorial. Any word or
picture on the screen can be linked to any re-
source on the Web. Most links connect you to
other Web pages or to bookmarks on the cur-
rent Web page, as shown in Figure 5-12. As
you learned in Chapter 2, however, any multi-
media file or application can be the object of a
link on the World Wide Web. For example,
your term papers, scholarly publications,
software, and multimedia applications can all
be mounted on the World Wide Web and
linked to your résumé so potential employers
can review samples of your work. It is also
common to find e-mail addresses linked to
Web pages in a so-called mailto link; when
you click the mailto link, an e-mail window
opens, addressed to the person whose address
is in the mailto. You learn how to create
mailto links in Chapter 6.

Special Characters

Web pages can contain special symbols such as the Greek characters used
in scientific notation, as well as mathematical functions, operators, delim-
iters, accents, arrows, and pointers.

Tables

Normally, the text of a Web page flows evenly onto the screen, aligning it-
self automatically with the left and right edge of your browser’s window.
The table is a design element that provides a way of dividing the screen
into rectangular regions into which you can lay out text and graphics on a
Web page. Text flows inside the rectangles of the table, creating a colum-
nar appearance much like the columns of text that appear in printed news-
papers. Graphics can also be made to flow into tabular columns. The
borders of the rectangles in the table can be visible, creating onscreen di-
viding lines between the table elements, as shown in Figure 5-13, or the
border can be invisible, as illustrated in Figure 5-14. Chapter 6 provides a
lot of practice using tables to lay out Web pages.

Frames

Have you ever seen a TV that supports a feature called picture in a picture?
While viewing one television program full-screen, you can watch another

FIGURE 5-12 Named anchors work like bookmarks to provide easy
access to sections within a Web page. �

note When HTML was invented,
there was no support for tables, and all
Web pages looked pretty much the same
in terms of design and layout.HTML was
enhanced to provide this support, and
today, tables are the most powerful way
of positioning items on a Web page to
create more interesting designs.
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program in a smaller onscreen window. On
Web pages, frames serve a similar purpose. The
term frame refers to the border that appears
around windows on your screen. When Web
pages contain frames, more than one window
appears on your Web page, and you can interact
with the information in the windows independ-
ently. The collection of these inner windows is
called a frameset.

You can try out frames for yourself by fol-
lowing this book’s Web site link to the presenta-
tion entitled “Emerging Technology and the
Future of Education.” This presentation was
authored in Microsoft PowerPoint. The Web
version was created by PowerPoint’s Save As
Web Page feature. Figure 5-15 shows how the
Save As Web Page feature uses frames to pro-
vide you with three windows in the Web
browser. The big window shows the slides. The
window on the left displays an outline of the
presentation. The window at the bottom dis-
plays the speaker notes that go with each slide.

FIGURE 5-13 Visible table borders help users follow
data across the table. You should turn

the borders on when you are displaying this kind of data. �

FIGURE 5-14 Invisible borders permit a table to govern subtly the positioning of
Web page elements. You make the borders invisible by setting
their width to 0. �



Understanding Screen Design Principles

The hands-on tutorial in this part of the book teaches you how to create a
Web page résumé. You will flow text onto the screen, create bulleted lists,
and link items in the list to the different parts of your résumé. Then you
will put pictures on the screen, either as backgrounds that appear behind
the text or as design elements around which text flows. Before you begin, it
is important to understand a few principles of Web page design that will
help you make good layouts for your screens.

Layout

As you learned earlier in this chapter, Web pages consist of several design
elements, including headings, paragraphs, horizontal rules, lists, images,
backgrounds, bookmarks, links, special characters, tables, and frames.
The relationship among these elements on the screen is called layout.
When you create a Web page, you should plan its layout so your content is
presented with good balance. Think of dividing the screen into regions, of
which some will be pictorial, with others consisting of blocks of text. You
must also think about how the user will interact with your screen and in-
clude the appropriate navigational buttons and hypertext links.

Internet Technologies at Work

FIGURE 5-15 This frameset provides three windows for viewing and controlling a PowerPoint presentation
on the Web. PowerPoint created this frameset automatically when I used the PowerPoint

option to save the presentation as a Web page. You learn how to create framesets in Chapter 7. �

You can click items in the
menu to jump to any slide.

The slides appear in
this large window.

The speaker’s notes
appear in a smaller frame.
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Figures 5-16 through 5-21 analyze the screen layouts of some example
Web pages. Notice how some rely heavily on text, and others are more
graphical. All the sample screens provide intuitive ways to navigate that
make these Web pages user-friendly. Chapter 6 will show you how to use
tables to lay out Web pages in rectangular regions such as these.

FIGURE 5-16 Textual Screen Design � FIGURE 5-17 Layout analysis of Figure 5-16 �

Text links

FIGURE 5-18 Graphical screen
design �

FIGURE 5-19 Layout analysis of
Figure 5-18 �

Graphics links
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Font Selection

Most Web browsers support the fonts listed in Figure 5-22. Web pages can
either set these fonts specifically or leave the choice of the font up to the
user. When no font is specified, the browser displays text in the default
font. Most people have the default font in their browser set to Times New

Roman. The Arial font, however, is
generally considered to be more
readable on Web pages.

All of the fonts illustrated in Fig-
ure 5-22 are proportionally spaced
except Courier. Proportional spac-
ing means that fat letters like m and
w take up more space than thin let-
ters like l and i. Normally you will
want to use a proportional font, be-
cause proportional spacing is easier
to read than nonproportional
fonts. However, if you want to
make columns of numbers line up
precisely on the screen, such as in a
spreadsheet, you will need to use
the nonproportional Courier font.
Figure 5-23 illustrates the differ-
ence between proportional and
nonproportional spacing.

FIGURE 5-20 Mixed screen design � FIGURE 5-21 Layout analysis of Figure 5-20 �

Graphics links

Text links

note For a font to appear
on a Web page, that font must
be installed on your computer.

FIGURE 5-22 Most Web browsers support the fonts listed here. Times New Roman is
the default font, although the Arial font is generally considered to be

more readable on Web pages, especially when the text is very small. Book Antiqua creates a
schoolbook effect, and the Comic font creates a handwritten look for less formal situations. �



Times and Arial are the most popular proportionally spaced fonts.
The primary difference between the Times and Arial fonts is that Times
has serifs, whereas Arial does not. A serif
is a decorative line stemming at an angle
from the upper and lower ends of the
strokes of a letter. Figure 5-24 compares
a few characters from the Times and
Arial fonts, pointing out the serifs in the
Times font.

Much of the fancy, stylized text you see
on the Web is actually a graphic that was
made from a font on a graphic artist’s com-
puter. This book’s Web site links to some
cool sites where you can make fancy text
for use in banners and other places where
you might want highly stylized text. In
Chapter 6, you learn how to put these
kinds of images onto your Web pages.

Text Sizing

Text size is measured in points, which tell how high the text is. In print me-
dia, a point is one seventy-secondth (1/72) of an inch. On a typical com-
puter screen, a point is about the height of a single pixel. Because monitors
are different sizes, the actual size of the text varies somewhat, depending
on the physical height of the screen. Figure 5-25 illustrates different point
sizes used on the Web.

Foreground vs. Background Colors

You can select from a wide range of colors for the text and the back-
ground of a Web page. Some color combinations work better than oth-
ers. Figure 5-26 illustrates recommended color combinations as well as
colors to avoid.

There are sites on the Web where you can see what different color com-
binations look like. To explore different foreground/background combi-
nations, follow this book’s Web site links to Color Pickers.
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FIGURE 5-23 Compare the proportional spacing on the left to the nonproportional spacing
on the right. Because nonproportional spacing appears regimented, save it for

situations in which you need things to line up, such as the columns in a spreadsheet. �

FIGURE 5-24 When you compare the Times New Roman and Arial fonts,
you notice that Times New Roman characters have special

effects called serifs, which are not used in Arial. This may help explain why the Arial
font is generally regarded as easier to read on a Web page, especially when the text
is small and there is not as much room for the serifs. �

FIGURE 5-25 Comparison of point
sizes. The higher the

point size, the larger the font. �
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Photographic Backgrounds

Exercise care when placing text on photo-
graphic backgrounds. Some photos are so
busy that text placed atop them is difficult to
read. Bolding can improve the readability of
text placed on photographic backgrounds.
Figure 5-27 illustrates text printed on top of a
background photo in different colors and
sizes, with and without bolding.

Tiled Backgrounds

A tiledbackground is a graphical effect created
when a bitmap smaller than the screen is drawn
repeatedly up, down, and across the screen until
the entire screen surface has been covered. As il-
lustrated in Figure 5-28, a tiled background can
create a special effect on a Web page. You must
be careful, however, to select a tile that does not

interfere with the readability of the text printed on top of it.
Tiles should be seamless, meaning that when the bitmap replicates itself

up and down the screen, you cannot perceive the edges of the bitmap or de-
tect a regular interruption in the pattern caused by the edges of the bitmap
not fitting against each other smoothly. Figure 5-29 shows an example of a
bad tile, in which you can clearly see a rectangular interruption around the
edges of the bitmap. It is also difficult to read the text on top of this tile,
making it a doubly bad choice on a Web page.

Navigational Icons

Some Web pages contain navigational
icons that give the user the option to page
forward or backward, go to a menu, or re-
turn to a home page. Navigational icons
normally work best when they appear
lined up in the same region of the screen
instead of scattered about the screen. Try
to position the icons in a logical order. For
example, it is logical to place the page-
back icon in the lower left corner of the
screen and the page-forward icon in the
lower right. Here is a suggested sequence
of icons that gives the user the option to
page back, return to the menu, go to a
home page, or page forward:

FIGURE 5-26 Compare the recommended colors on the left with the
color combinations to avoid on the right. You will probably

agree that the colors on the right are not as easy to read as those on the left. �

t ip As you explore the use of
colored backgrounds, keep in mind that
the most readable combination is black
text on a white background. Because
you want the bulk of your text to be
readable, save the razzle-dazzle colors
for special effects.

FIGURE 5-27 Sizing, bolding, and coloring affect the readability of text on a
photographic background. Notice how the color combinations

with greater contrast are more readable than the colors that blend. �
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Scrolling

When you design a Web page, keep in mind that the user can scroll up and
down through the information in it. Imagine what the user will see on each
screen of your Web page document, and plan the layout accordingly. If
your document is long, provide navigation options periodically in the
midst of the document instead of putting them only at the end. Otherwise,
the user will have to scroll all the way down to find the navigation options.

When you have a long document, organize it into sections divided by
horizontal rules, and put the navigation options at the end of each section.
You learn how to do this in Chapter 6 by providing navigation options at
the end of each section of your Web page résumé.

As a general rule, it is best to keep the front page of a Web site short if
you can, and use it to provide links to the longer pages. My home page at
www.udel.edu/fth is very short, for example, and some of the documents it
links to are quite long.

Usability

Web pages need to be easy to use. When you plan your layout and decide
where you will place pictures and text on your screen, make sure you in-
clude navigational buttons, icons, or hypertext to clarify what the naviga-
tional options are and where the user should click to navigate.

Word your hypertext links to make it clear what will happen when the
user clicks them. Descriptive phrases are better than single words. A de-
scriptive phrase such as “table of contents” tells what will come onscreen
when the link is clicked. Try to avoid the temptation to include the word
“click” in your instructions. Telling users to click this to go here and click
that to go there gets old after a while and sounds overly technical.

FIGURE 5-28 Example of a seamless tile in the background of
a Web page. This tile image is: �

FIGURE 5-29 Example of a bad tile that is not seamless and
interferes with the readability of the text. This
tile image is: �



Iconic navigation is often more effective than words, takes up less
screen space, and works better with international audiences because the
icons can be understood regardless of what language the user speaks.

Be consistent. If you adopt navigational icons, use them consistently
throughout your Web site. If you use hypertext navigation, be consistent in
how you word the directions.

Consistency

Avoid the temptation to demonstrate every trick you know when you de-
sign a Web page. Keep it simple. Do not make every screen look and work
a different way. Rather, adopt a common look and feel so the user will be
able to navigate through your Web site intuitively.

It is frustrating to use a Web site with mixed metaphors and icons that
change their meaning on different screens. Be consistent.

Analyzing the Layout of a Web Page Résumé

Figure 5-30 contains a layout analysis of a Web page résumé. Notice how
the text, fonts, sizes, and colors enhance the readability of the text. Each
item in the menu serves as a hypertext that links to different sections of the
résumé. The navigation options at the end of each section make it clear
how to move around on the page. The common look and feel of each sec-
tion makes it easy for a prospective employer to find out about your job
skills and work experience.

Internet Technologies at Work
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FIGURE 5-30 Layout analysis of a Web page résumé. This is my résumé, which you can visit on the Web at www.udel.edu/fth/resume.html.
The HTML tutorial in Chapter 6 steps you through the process of creating your own Web page résumé, which will come in
handy whenever you are looking for a job. �

This is linked to the target
named “contents.”

This is the target
named “contents.”

This is your picture.

Horizontal rules clearly define
each section of the résumé.

The menu is the most
important design element in
this Web page résumé.

Navigation options at the end
of each section make it easy
for an employer to navigate
your résumé.



Chapter 5 Review

■ Chapter Summary
After reading this chapter and completing the step-by-
step and Try This! exercises, you should understand
the following facts about Web page authoring:

Adopting a Web Page Creation Strategy

■ There are four ways to create Web pages. First,
you can use a plain text editor to type the HTML
code of your Web page by hand. Second, you can
use an HTML editor that contains toolbars and
menus that help you insert the codes. Third, you
can use the Save as Web Page option to convert
word-processed documents into Web pages.
Fourth, you can use a WYSIWYG editor to create
Web pages through a graphical user interface that
lets you enter text and graphics directly onto the
screen exactly as you want them to appear.

■ Because HTML is a textual encoding language, you
can use a plain text editor to create HTML Web
pages. All Windows and Macintosh computers have
a built-in text editor called Notepad, which you can
use to create HTML Web pages.

■ An editor that lets you create Web pages by
working directly with the HTML tags is known as
an HTML editor. HomeSite is the most popular
HTML editor for Windows. On the Macintosh,
the most well-known HTML editor is BBEdit.

■ An HTML translator is a tool that can convert an
existing document into the HTML format.
Microsoft Word, Excel, Access, and PowerPoint
have HTML translators built in.

■ WYSIWYG is an acronym that stands for what
you see is what you get. WYSIWYG editors let
you create Web pages by typing your text directly
onscreen, where it appears exactly as it will look
on the Web. Dreamweaver, FrontPage, and
Netscape Composer are three popular
WYSIWYG Web page editors.

Defining the Elements of Web Page Design

■ World Wide Web pages consist of elements
defined in the HTML language that is used to
create Web pages. These elements include
headings, bookmarks, paragraphs, links,

horizontal rules, special characters, lists, tables,
images, frames, and backgrounds.

■ There are six heading styles, numbered from H1 to
H6. The smaller the number, the bigger the heading.

■ A horizontal rule is a design element used to
create a divider between sections of a Web page.

■ Lists can be ordered or unordered. In an ordered
list, the items are numbered automatically; in an
unordered list, the items are bulleted.

■ Images can be left justified, right justified, or
centered on the screen. Text can be made to flow
around the left or the right side of an image.

■ Backgrounds can be filled with a solid color, or
you can tile a bitmap into the background to
create a textured appearance. It is important to
choose a background that does not detract from
the readability of the text. For this reason, black
text on a white background is the most frequent
color choice on the Web.

■ A bookmark is a named anchor to which you can
link a hot word or menu item to provide a way
for the user to jump around to different places
within a Web page.

■ Links are the most essential element in Web
design, because links create webs. Without links,
there would be no webs.

■ Tables provide a way of dividing the screen into
rectangular regions into which you can lay out
text and graphics on a Web page.

■ The term frame refers to the border that appears
around windows on your screen. When Web pages
contain frames, more than one window appears on
your Web page, and you can interact with the
information in the windows independently. The
collection of these inner windows is called a
frameset.

Understanding Screen Design Principles

■ The relationship among the elements that appear
onscreen is called layout. When you create a Web
page, you should plan its layout so your content is
presented with good balance. Think of dividing the
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screen into regions, of which some will be pictorial,
with others consisting of blocks of text. You
must also think about how the user will interact
with your screen, and include the appropriate
navigational buttons and hypertext links.

■ When no font is specified, the browser displays
text in the default font. Most people have their
browser’s default font set to Times New Roman,
although the Arial font is generally considered to
be more readable on Web pages, especially when
the text is very small. Book Antiqua creates a
schoolbook effect, and the Comic font creates a
handwritten look for less formal situations.

■ Proportional spacing means that fat letters like m
and w take up more space than thin letters like l
and i. Normally you want to use a proportional
font, because proportional spacing is easier to
read than nonproportional fonts. If you want to
make columns of text line up precisely on the
screen, you need to use the nonproportional
Courier font. Because nonproportional spacing
appears regimented, save it for situations in which
you need things to line up, such as the columns in
a spreadsheet.

■ Text size is measured in points, which tell
how high the text is. In print media, a point is
one seventy-secondth (1/72) of an inch. On a
typical computer screen, a point is about the
height of a single pixel. Because monitors are
different sizes, the actual size of the text varies
somewhat, depending on the physical height
of the screen.

■ Sizing, bolding, and coloring affect the readability
of text on colored or photographic backgrounds.
Color combinations with greater contrast are
more readable than colors that blend.

■ A tiled background is a graphical effect created
when a bitmap smaller than the screen is drawn
repeatedly up, down, and across the screen until
the entire screen surface has been covered. You
must be careful to select a tile that does not
interfere with the readability of the text printed
on top of it. Tiles should be seamless, meaning
that when the bitmap replicates itself up and
down the screen, you cannot perceive the edges of
the bitmap or detect a regular interruption in the
pattern caused by the edges of the bitmap not
fitting against each other smoothly.

■ Navigational icons normally work best when they
appear lined up in the same region of the screen
instead of scattered about the screen. Try to
position the icons in a logical order. For example,
it is logical to place the page-back icon in the
lower left corner of the screen and the page-
forward icon in the lower right.

■ Imagine what the user will see on each screen of
your Web page document, and plan the layout
accordingly. If your document is long, provide
navigation options periodically in the midst of the
document instead of putting them only at the end.
Otherwise, the user will have to scroll all the way
down to find out the navigation options.

■ Word your hypertext links to make it clear what
will happen when the user triggers them. Descriptive
phrases are better than single words. A descriptive
phrase such as “go to the table of contents” tells
what will happen when the icon is clicked.

■ Iconic navigation is often more effective than
words, takes up less screen space, and works
better with international audiences because the
icons can be understood regardless of what
language the user speaks.

■ It is frustrating to use a Web site with mixed
metaphors and icons that change their meaning
on different screens. Be consistent. If you adopt
navigational icons, use them consistently throughout
your Web site. If you use hypertext navigation, be
consistent in how you word the directions.

Analyzing the Layout of a Web Page Résumé

■ Layout analysis diagrams the positional and
navigational relationships among the textual and
graphical elements of a Web page.

■ When you design a Web page, think about the
menu choices and navigational options you want
to provide for your site’s visitors.

■ Plan the layout according to what you want the
user to see on each screen of your Web site.
Visualizing the layout prior to creating the pages
can save you a lot of time in Web development.

■ Remember to be consistent and avoid mixing
metaphors. Use navigational icons consistently,
and make hypertext links intuitive by wording
the text in such a way that users know what will
happen when they click.

Chapter 5: Creating Web Pages
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■ Key Terms
bookmark (15)
frame (17)
frameset (17)
heading (13)
horizontal rule (13)
HTML editor (5)
HTML translator (7)

layout (18)
link (16)
Notepad (5)
proportional font (20)
point size (21)
ordered list (14)
seamless (22)

serif (21)
table (16)
tags (5)
tiled background (22)
unordered list (14)
what you see is what you get

(WYSIWYG) (10)

■ Key Terms Quiz
1. The special codes that mark up the text of an

HTML document are called ________________.

2. WYSIWYG is an acronym that stands for
____________________.

3. There are six ____________________ styles,
which are numbered from H1 to H6.

4. The Web page design element that creates a
divider between sections of a Web page is called
a(n) ____________________.

5. On a Web page, lists can be ordered or
unordered. In a(n) ____________________ list,
the items are numbered automatically; in a(n)
____________________ list, the items are
bulleted.

6. Normally, the text of a Web page flows evenly
onto the screen, aligning itself automatically
with the left and right edges of your browser’s
window. The ____________________ provides a
way of dividing the screen into rectangular
regions into which you can lay out text and
graphics on a Web page.

7. When Web pages contain frames, more than
one window appears on your Web page, and
you can interact with the information in the
windows independently. The collection of these
inner windows is called a(n) ________________.

8. Web pages consist of several design elements,
including headings, paragraphs, horizontal
rules, lists, images, backgrounds, bookmarks,
links, special characters, tables, and frames.
The relationship among these elements on the
screen is called ____________________.

9. In print media, a(n) ____________________ is
one seventy-secondth (1/72) of an inch. On a
typical computer screen, this is about the height
of a single pixel.

10. A bitmap that repeats up, down, and across
the screen until the entire screen surface
has been covered is known as a background
____________________.

■ Multiple-Choice Quiz
1. What kind of a tool lets you create Web pages

by working directly with the HTML tags?
a. HTML editor
b. HTML translator
c. Layout analyzer
d. WYSIWYG

2. What is the most popular HTML editor for
Windows?
a. BBEdit
b. HomeSite
c. Notepad
d. WordPad
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3. What is the name of the Macromedia program
you can use to create Web pages from a Code
view, a Design view, or a Split view that
combines both the Code and Design views?
a. Composer
b. Dreamweaver
c. FrontPage
d. WebEdit

4. Which Web page editor was designed for use
with Microsoft Office?
a. Composer
b. Dreamweaver
c. FrontPage
d. WebEdit

5. Which Web page editor ships freely as part of
Netscape Navigator?
a. Composer
b. Dreamweaver
c. FrontPage
d. WebEdit

6. What is the most frequent color choice on
the Web?
a. Black text on a white background
b. Black text on a blue background
c. White text on a red background
d. Yellow text on a brown background

7. Which color combination provides the most
contrast onscreen?
a. Black text on a gray background
b. Black text on a white background
c. Gray text on a black background
d. Gray text on a white background

8. What kind of link causes an e-mail window to
open onscreen?
a. FTP
b. Hypertext
c. Mailto
d. News

9. Which of the following fonts uses
nonproportional spacing?
a. Arial
b. Book Antiqua
c. Courier
d. Times Roman

10. When you cannot perceive the edges of the
background tile or detect a regular interruption
in the pattern caused by the edges of the tile
not fitting against each other smoothly, the
background tile is said to be:
a. Aligned
b. Proportional
c. Repetitive
d. Seamless

■ Essay Quiz
1. In your own words, describe when it is best to use an HTML editor, a WYSIWYG tool, or an HTML

translator to create a Web page.

2. Go to Macromedia’s HomeSite page at www.macromedia.com/homesite. What is the version number of
the latest HomeSite update? What is the hottest new feature you see advertised for the latest update?

3. Using the design elements presented in this chapter, plan the layout of your Web page résumé. Think
about the menu choices you want to provide prospective employers who visit your Web page to find
out about your experience and qualifications. Include this menu as one of the design elements in your
résumé. Possible menu items include:

� Educational Qualifications � Professional Association Memberships

� Work Experience � Publications

� Computer Skills � Software

� Grants and Awards � Presentations

� Honorary Societies � How to Contact Me
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If you are just starting out, you may not have this many items, but remember not to be shy on a résumé.
Think about all the things you have done, the part-time jobs you have had, the organizations for which
you have volunteered, the sports teams on which you have played, and the clubs you joined. You
probably have more things to list on a résumé than you can think of at first. You do not want to go
overboard, however, because a résumé should be succinct, but if you cannot fill a screen or two, think
harder about the things you have done in life.

4. Because you can link any document, audio, picture, movie, or software application to your Web page,
you can link your résumé to examples of your work to prove your worth to a prospective employer.
What examples would you like to link to your résumé? Include these links in the design of your résumé.

5. There is a knack to writing hypertext in such a way that the wording makes it clear what will happen
when the user triggers the link. Write three examples of text containing a word or a phrase which, when
clicked, takes the user to your home page.

6. Draw three different ways of providing an icon that moves forward to the next screen of an application.

Lab Projects

• Lab Project 5-1: Web Page Creation Strategy
When employees can create their own Web pages and publish them to the Web, a school or company
becomes much more efficient in posting and sharing information. Hyperlinking enables the Web page author
to link items on the page to other information that a coworker, student, or customer might be expected or
encouraged to access as related information. The search engine selected in Lab Project 2-3 will enable users to
search via keyword for any other page at the site to which they have access. This kind of information-publishing,
linking, and search capability is the very reason Tim Berners-Lee gives for inventing the Web back in 1989.
In his 1989 proposal for creating the Web, Berners-Lee (1989, ¶ 5) said his goal was to help his coworkers
keep track of things in a large project. Imagine that your employer wants to empower your coworkers to
take advantage of the power of publishing, linking, and searching school or company information on the
Web. Your employer wants you to recommend a Web page creation strategy that is appropriate for your
workplace. In developing a recommendation for the best approach for your school or company to take in
creating Web pages, consider these issues:

■ Technical support How much technical support is available to coworkers in your school or company?
If your company has an IT organization with a support staff that helps employees troubleshoot technical
problems, you may be able to recommend a more technical solution than for a small company or school
that does not have a lot of technical support staff, if any.

■ Other software products Take into account other software products that your school or company is
already using. If all your coworkers are using Microsoft Office, for example, that might direct your choice
toward a FrontPage solution. If your school or company has adopted Netscape as its standard browser,
on the other hand, Netscape Composer may be the obvious choice.

■ Training How will your coworkers learn how to use the Web page creation software you recommend?
If you recommend FrontPage or Netscape Composer, you could use the Web page creation tutorial in
McGraw-Hill’s Internet Literacy textbook as training material.
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Use a word processor to write up your answer to this assignment in the form of a two-part essay. In the
opening paragraph, tell what Web page creation strategy you recommend and briefly state the reason for
choosing it for use in your workplace. Then write another paragraph or two describing the other approaches
you considered, and state your reasons for rejecting them. Conclude your recommendation with a paragraph
describing how empowering you feel your recommended strategy will be, and give examples of a few ways
in which creating Web pages in this manner will empower your coworkers and improve operations in your
workplace. If your instructor has asked you to hand in this assignment, make sure you put your name at the top;
then save it on disk or follow the other instructions you may have been given for submitting this assignment.

• Lab Project 5-2: Adopting a Common Look and Feel
Whether or not the Web page author is aware of it, every Web page has a certain look and feel. If the look
and feel is consistent from page to page, coworkers and others who visit the site frequently get used to
looking in certain places on the page to find such things as menus, link bars, headlines, different kinds of
content, and navigation buttons. If the look and feel is not consistent from page to page, the user must spend
more time finding where things are on the page. This is inefficient at best and can be frustrating as well.
Imagine that your employer has decided that your school or company Web site needs to adopt a common
look and feel. Your employer has asked you to create a design specification recommending a common look
and feel for Web pages created in your workplace. In creating this design spec, address the following issues:

■ Templates What kinds of pages do your coworkers typically create? The pages probably fall into a few
basic types, such as home pages for different projects or products, search pages for finding things, catalog
pages for listing products for sale, and document pages containing reports, product information, or
scholarly papers.

■ Design elements What are the design elements that are likely to appear on the kinds of pages you
identified? Make an outline that lists the basic kinds of pages typically used in your workplace. Under
each kind, list the design elements that appear on that kind of page. Consider all the different elements
that can appear on your workplace Web pages, such as banners, menus, search buttons, quick links,
newsfeeds, headlines, navigation buttons, pictures, icons, logos, prose, products, catalogs, advertisements,
and bibliographies.

■ Positioning Add to this outline an indication of where each element will go on the Web page. If you are
not sure where things should go, visit some Web sites of organizations like yours and study their Web
page designs. If you have FrontPage, you can look at the built-in templates there. Pull down the File
menu, choose New | Page, and click the option to see the templates. As you click each template, a preview
pane shows the layout. There is also a template gallery at officeupdate.microsoft.com/templategallery.
Surf these templates and visit other Web sites in your industry or subject matter to get more design ideas.

■ Navigation Include in your design spec a strategy for placing navigational elements at consistent places
onscreen.

Use a word processor to write up your answer to this assignment in the form of a three-part essay. In the
first part, describe the overall approach you recommend. Mention the three or four basic kinds of templates
you feel your school or company needs. In the second part, present the outline of design elements that will
typically appear on each template. Conclude by describing where onscreen these design elements will appear.
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If you are graphically inclined, you can use your word processor’s table feature to create a prototype of the
screen designs you envision. Otherwise, you can describe the layout prosaically. Make sure you specify where
the navigational elements will be onscreen. If your instructor has asked you to hand in this assignment, put
your name at the top; then save it on disk or follow the other instructions you may have been given for
submitting this assignment.


